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User manual for SkyScan reconstruction program NRecon 
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Introduction : NRecon in a nutshell 

SkyScan NRecon package is used to reconstruct cross-section images from tomography 

projection images, mainly the cone-beam X-ray projections. The algorithm implemented is 

the Feldkamp algorithm. The native SkyScan data are recognized automatically. This 

program can also reconstruct non-native tomography data, if the file format and file names 

follow the conventions described in chapter 3, and a corresponding log file is created 

following the instruction described in chapter 4.  

The program is provided together with a help file with detailed information on how to use the 

software. This additional document serves as a manual for quick startup, and it overlaps 

largely with the online help. There are also a number of related technical notes available upon 

request.  

The reconstruction software package consists of 2 programs:  the user interface program 

NRecon and the reconstruction engine NReconServer. The two programs can run either on 

the same computer or on a cluster of computers. The communication between NRecon and 
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NReconServer uses a client-server model (a common port). If windows firewall is enabled, 

you will be asked to unblock it for the server program.  Data are shared among the PCs using 

shared directory via network:  please make sure that all PCs involved have access to both 

input and output directories.  

A typical configuration (see Figure 1) is a combination of 1 host computer and N 

(N=1,2,3,4,....) reconstruction nodes, as configuration 1 shown below. Or, you can run it as in 

configuration 2, with or without extra node PCs.  Ideally, the node PCs should be high-

definition: dual (or more) processors, large RAM (minimum 1GB if  8Kx8K reconstruction 

will be performed), fast FSB, minimum 40GB hard disk (excluding data storage) if 8Kx8K 

reconstruction will be performed.  

 

Figure 1  Typical layouts of NRecon/NReconServer 

Chapter 1    Installation, configuration and license   

It is rather straightforward to install and configure the reconstruction program NRecon: 

simply copy the programs to your destination folder. More details can be found in the 

installation guide which is part of the online help.   

The programs run under Windows operating systems (32-bit and 64-bit). It is important to 

install the 64-bit server program on a 64-bit computer to ensure maximum performance. For 

the user interface program NRecon, only 32-bit version is provided, which runs on both 32-

bit and 64-bit systems.  

There are 2 versions of NRecon/NReconServer available: the local and distributed/cluster 

version.  The local version is free.  
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The local/free version:   please download and install the local NRecon/NReconServer.  There 

is no limitation in functionality. As the name suggests, both programs have to run on the 

same computer.  For each NRecon, only one server can be connected to.  

The distributed/cluster version:   you need a license to run this copy.   To apply for a license, 

please note down the product ID (found in menu Help->About NRecon ...; or in the warning 

message when no license or an invalid license is found by a distributed version), and send the 

ID together with a user name and your institution/company name to your distributor or to 

SkyScan. More information can be found on our website: http://www.skyscan.be.    

To install license:  the NRecon.lic has to be in the same directory as NRecon.exe. By the first 

startup, you need to fill in the product ID, name and company name exactly as you received 

from SkyScan (case-sensitive; please use copy-and-paste to avoid typing   errors).    

Chapter 2    General layout and usage of the software 

If you have a local version, just start up NRecon: the server program will be started up 

automatically if it was not yet on. You may skip 2.1 which is specific for distributed/cluster 

version.   

The NReconServer(local) will only accept connection requested by NRecon running on the 

same computer.    

In case of multi-user environment, it is recommended to run only one copy of the server 

program at the same time:  the computation resources are used more optimally. 

 2.1 Start the cluster reconstruction program and the client-server connections  

     In general, the server program should be started first, but it is not strictly necessary.  If 

you exit the server program, turn off one of the node PCs or unplug one of the network 

cables while NRecon is on and connected,  NRecon will be informed and show the status 

correctly. However, if you start up a server program while NRecon is already on, you need to 

re-establish the connection.   

    Neither NRecon nor NReconServer allows more than one copy running on the same 

computer.  In case of multi-user workstation (multiple users can log on simultaneously), only 

one copy of the server program can be started at a fixed port number: it is then recommended 

to install the server program only on one (common) account, so that you do not have to worry 

about different port number or multiple instances of the server program on a single machine.   

    The server only "serves" one NRecon at one time (the active client), but it does hold a 

numbered waiting list and it will inform all connections (the connected NRecon 

programs) whenever this status changes.    An active client gives up its "privilege" only when 

it disconnects from the server, and the first waiting client will be promoted to be the active 

client. In case of multiple NRecon instances, communication among the users may be 

required to use the limited computer resource efficiently.  For a smooth operation in a multi-

user environment, it is recommended to disconnect the servers whenever they are not needed 

any more. 

http://www.skyscan.be/
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 2.2 Layout and walk around     

 Figure 2 shows the typical appearance of NRecon and NReconServer. Little explanation is 

needed for NReconServer:  only the communication port number and the number of threads 

can be altered by the users.  The port number should be the same as that used in NRecon 

(default to 1) and usually does not require modification.  The number of threads influences 

reconstruction speed. The layout of NRecon is more complicated.  

 

Figure 2 Typical appearance of NRecon + NReconServer: the local version 

   There are a few windows on the application window of NRecon: The main display where 

the images are shown, the reconstruction window which hosts a few pages/tabs (start, 

settings, advanced, output, summary) for reconstruction purposes, the connection window 

which shows the status and progress of all servers, the color window which allows you to 

view the images in the main display in different color and scale.  Except the main display, all 

other windows are so-called dockable windows: you can drag them out of the main window, 
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or dock them differently than they are shown here. You may customize the appearance of 

NRecon to your taste and convenience like most windows programs: the last used layout will 

be saved and loaded automatically at next startup.  You can also show/hide these dockable 

windows by closing the individual windows or via the View menu.  

    Since there is only one display area, a few display modes are used:  navigation mode, 

alignment mode, preview mode, image mode and idle mode.  These display modes are 

coupled to the different pages/tabs on the reconstruction window.  In other words, switching 

from one display mode to another is done by switching from one page to another on the 

reconstruction window.   

The color window is also coupled to the display modes, i.e., each display mode has got its 

own settings for display. 

A general scenario of reconstruction is the following:  after loading a dataset, NRecon will be 

set at the Start page and the display will be in the navigation mode, where the projections can 

be viewed; go to the Settings page to check the parameters, usually the display will be in 

navigation mode to allow you to check the alignment; go back to the Start page to do a 

preview; NRecon goes automatically to the Output page after reconstructing a slice for 

previewing, the display will be set at previewing mode, and you can modify the parameters 

concerning final output image; You may go the Advanced page for further parameters 

adjustment, or to the Summary page to view the scan parameters and reconstruction 

parameters; once all parameters are set, go back to Start page to start the full reconstruction 

or send the reconstruction task to the batch manager.  

The sections below will give more details on the different pages on the reconstruction 

window and the batch manager.  

2.2.1 The Start page  

This is the default page when a dataset is loaded, if no post-alignment is set automatically at 

loading time.   

This window/page offers possibility to select axial reconstruction range, to start a 

reconstruction or to submit a batch job. It is coupled to the main display: setting this page 

active will set the main display to navigation mode in which a shadow image will be shown.   

Figure 2 is a snapshot taken when this page is set active.  To view other shadow images, you 

can click on the up/down arrows on the toolbar; or invoke a popup 

window by clicking on the second button.   

The green line on the main display in the navigation mode indicates the slice for previewing. 

The dark-red lines indicate the slice range for volume reconstruction.  These lines can be 

dragged to a desired location (left mouse button). The corresponding slice numbers are also 

shown on the start page, and can be altered from there as well, by either editing or scrolling.  

Please note, this range indication is only a rough guide due to the cone-beam geometry.  

Therefore, one should foresee a safe margin or do a preview to confirm when selecting the 

slices. 
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The functions provided on the Start page are described here.     

ü Preview:  

   This function is provided to adjust the various parameters. It basically reconstructs one slice 

of choice. To change the slice on which a preview reconstruction will be performed, you can 

drag on the green line with mouse move, use the spin button, or simply type in a slice 

number.    

    In preview mode, only the parameters shown on settings/advanced page will be taken into 

account, while the parameters shown on Output option page will be ignored silently.  For 

example, the region-of-interest option is ignored so that you can draw ROI on the full 

preview image.   When preview reconstruction finishes, the Output option page will be 

automatically set active, offering you the chance to modify a few output parameters for the 

final results, such as the dynamic image range, output format, scales, color and etc.   

   The major aim of previewing is to help you adjust parameters.  You can always switch back 

and forth between the pages to adjust them. To help you associate the parameters with result, 

the slice number (e.g.,  Prv 0514) is shown on the status bar whenever the preview image is 

in display.  If any change occurs which might result in different image quality, a * will be 

shown (e.g., *Prv 0514).   

ü Fine tuning:   

  A few reconstruction parameters have to be adjusted manually in a try-and-error fashion 

using the preview function. It requires quite some effort to save the preview images,  view 

them and then make a decision. The "fine-tuning" function is designed to make this 

adjustment somewhat easier by launching a series of previews.  You may adjust one 

parameter at a time, while keeping all other parameters fixed.  In this way, you may tune 4 

parameters: post-alignment, beam-hardening correction, ring artifacts correction level and 

smoothing level.   

Figure 3 shows the popup window appearing upon clicking on the fine-tune button. You may 

choose the parameter to tune, and the parameter values are given such that they are centered 

on the current value (the valid range of the parameters are taken into account as well) with 

given step size. Once you have set this, you can click on Start to start a series of preview 

reconstructions.    
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Figure 3  Fine-tune window 

  Once the preview reconstructions are done, you may use the buttons on the toolbar 

to scroll. The parameter is adjusted automatically when you scroll.  In other words, simply 

concentrating on the images until you find a satisfied one, and the fine-tuning function is 

done.   In case of doubt on the consistency, there is text information at the top-right of the 

image, indicating which preview you are viewing; or go to the Settings page, switch the 

alignment image off, and you will be able to view the preview image and observe how the 

parameter updates while scrolling.   If, accidentally or not, you have changed any parameter 

which does not correspond to any of the preview images, a * will be shown (e.g., *Prv 0514) 

on the toolbar, just as in the normal preview case.  

ü Start 

    Obviously, this is the button to start a reconstruction.   It checks for disk sufficiency and 

whether you want to overwrite files if there are already there.    

    When the first resulting image is available on the disk, it will be loaded automatically and 

the Overview page will be set active, showing the first reconstructed slice in image mode.  

Same as in navigation mode, you may walk through the resulting images by using the   

buttons. Please note that the images may appear non-sequentially due to work division 

among multi-threads and multi-computers.  

ü    Add to batch 

    Instead of reconstructing the volume immediately, you can send the reconstruction task to 

the batch manager. You can start the batch jobs later. Section 2.3.5 has more details about the 

batch processing.  

2.2.2 The Settings and Advanced page   
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There are two windows/pages for reconstruction parameters. These two windows offer 

possibility to change reconstruction parameters for the current dataset.  The most frequently 

used parameters are put in page Settings, and other more advanced parameters are grouped 

together in page Advanced.  

The Settings page can be coupled to the main display in 3 ways:  alignment mode, preview 

mode or navigation mode.  The alignment mode will  be switched on if both the post-

alignment option and the show option are checked; otherwise the preview mode (if 

previewing image is available) or the navigation mode will be switched on.   You may switch 

between two modes by check/uncheck the show option: convenient when you are adjusting 

parameters by looking at the existing preview image.    

The Settings page is set automatically active after loading if the post-alignment option is 

checked.  Figure 4 shows the settings page with alignment display mode.   This display mode 

is switched on when both the post-alignment option and the show option are checked. The 

image shown in display is the overlaid image (alpha-blending) of 2 shadow images at 

opposite positions (180 degrees apart).  One of the 2 images is flipped. The intention of this 

option is to help you choose the correct alignment value at the first stage. However, the 2 

images may differ a lot due to the cone-beam geometry and different magnification factors. 

Therefore, it is always recommended to use the previewing choose the post-alignment value.   

The initial/default post-alignment value is estimated at loading time. Instead of comparing the 

original cone-beam projections, we compare pseudo-parallel projections obtained from the 

cone-beam projections at 0 and 180 degrees. Only the central portion of the projections are 

used (you may change the portion of data used for post-alignment in Preferences.).  If you 

interrupt/cancel the rebinning, the original version as described above will be used instead.  

The profiling function is partially enabled: clicking on will show you 2 curves (profiles 

along the central horizontal line, average over the full vertical length).  Together with the 

profiles, the overlaid image provides a rather interactive way of adjusting the post-alignment 

value.  
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Figure 4 The Settings page with alignment display mode.  The profile window is also visible 

Figure 5 shows the Advanced page coupled with navigation display mode.  
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Figure 5 The Advanced page with navigation display mode 

When loading a dataset, the default value of each parameter is determined in various ways. 

Firstly, a few parameters (recommended beam-hardening correction, recommended HU 

calibration factor) are read from the corresponding configuration file companying each 

dataset if any, and the default post-alignment value is calculated if applicable. The static 

cross-section rotation and output image format are also assigned according to the settings in 

Options->Preferences.    Secondly, an attempt is made to search for a matching entry in the 

batch manager. If a matching entry is found, the parameters in the batch manager will be 

loaded exactly as they are and you will be asked if you want the entry in the batch file to be 

removed or not.  If no matching entry is found in the batch manager, an attempt is made to 

search the corresponding log file (<dataset>.log) for previously used parameters. They are 

loaded if found.  
























